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Where, oh where have my iCloud
documents gone??? Don’t miss Phil
Davis’ timely tip on the subject—
page 2.

Next Meeting - Sept. 11, 2012: 7 PM
Creating a Family Movie with iMovie
—presenter, Roberto Putzeys

January 2012
This month’s superb Member’s
Showcase features some favorite
images from Tim’s file— page 5.

Nine tips for taming your text
in Pages. A great path to improve
your documents— page 5.
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Procrastination will be my undoing yet!
Judy has been telling me for at least two
years we should get some additional
signers on our club bank account. She is so
dedicated and does such a good job; what
is the hurry? So, I think it is a good
idea – we should do that – sometime.
Then I forget. Now, Judy really needs to
concentrate her energy on getting well so
we have approached this with new zeal.
In case you were not at the August
21st meeting when I reported it verbally,
the board has authorized the President
(me) and the Vice President (Bobby
Adams), to be signers on our checking
account. The board also created the
new position of Assistant Treasurer with
authority to do all of the Treasurer’s
duties including signing club checks. This
position has been filled by Brian Voge.

We appreciate his accepting these duties. Getting all the
paperwork for all of us to the bank in proper form has been
a minor challenge since it is inconvenient for all of us to get
to the bank at the same time. I think we will have it under
control and in place by the time you read this.
Another procrastination that could have bit me is not
paying proper attention to my UPS system. (You do have a
UPS don’t you?) UPS –Uninterruptible Power Supply– in
the small system type I am referring to does two things for
you. It smooths out your incoming line power even better
than a good surge protector. More importantly, they
provide enough battery backup power to allow you to back
up open documents and shut your computer down smoothly in the event of a power outage. Your computer will not
even notice a momentary power blip that otherwise could
shut it down, possibly with damage. For more than you
need to know about UPSes (including the world’s largest)
click this hot link.
What has this to do with my procrastination? I have not
been testing my UPS on a regular basis. It is about three

years old. A month or so ago we had a momentary power
blip. It shut me down. I wondered why, so checked out
my UPS. The battery was dead. I thought “gee, I need to
do something about this” and then got interested in other
things and did nothing. As I’m typing this, Tropical Storm
Isaac is heading West and appears to be no immediate
threat. However as I was thinking about what to do for
storm preparation if need be, I remembered that storms
frequently cause power outages and/or “dirty” power and
I wished I had acted on my impulse to get a new battery.
I ordered one twenty minutes ago. It cost less than $20
and will give me peace of mind after I install it. If you have
to buy the entire unit instead of just a battery, you can get
one for considerably less than $100. BTW, If your computer
is a laptop the internal battery serves this purpose and you
need not worry about a UPS.
If you live in a flood prone area, this would be a good
time to think about a plan to get all your electronics off
the floor! Do you have a planned place to put them? If the
answer is no, think about it.
President

—NC Sizemore,
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Where are my iCloud Documents?

by David Boyd,
SmallDog.com

Touchscreen
Shortcuts—

But what about your keyboard-less
iPhone, iPod, or iPad; are there any
touchscreen interface shortcuts?
Apple has a website with you in
mind. Luckily for you, I have
assembled a list of my own favorites
which I’ve found by accident in the
last five years.
1. Double tap the Space bar in
order to end a sentence and begin a
new sentence.
2. Double tap the Shift key in
order to lock the caps lock. Tap once
to unlock.
3. Tap on the “.?123” key, hold,
and drag to the desired character
or numeral and release in order to
enter the character or numeral and
return to the alphabetic keyboard.
4. Tap and hold a letter on the
keyboard to enable accented versions of that letter.
5. Tapping and holding on text
brings up common options. Tap
select to select a word. Use left/
right arrow keys to extend options,
including bold/italics/underline as
well as define to get a definition.
6. In Safari, if you know the
domain of the web site you are trying to navigate to, you can type that
in, such as “yahoo” or “wikipedia”
or “smalldog” without the “www”
or “.com” and you should find that
Safari will get you there.
7. In Safari, when entering an
address in the address bar, tap and
hold the “.com” key to get access to
.net, .org, .edu sites
8. When you are looking at a
website, an email inbox list, or a
long mail message, tap the status
bar where the time is displayed and
you will jump back to the top of the
list. m m m m

by Phil Davis

Here is the scenario—
You have set up an iCloud account and have recently updated your Mac to Mountain Lion. You are
excited to know that you now have the ability to create iWork documents on your iMac and have them
immediately available on your MacBook Pro, your iPad, and your iPhone. All is good with the world so you
spend many hours creating an important Keynote presentation that you plan to present to a local Service
Club.
You carefully test the presentation on all your devices, spend time polishing and practicing, and are all set
for the big day. Grabbing your laptop you set off to the meeting room, plug the laptop into the projector
and open Keynote.
Whoops! Nothing is there. Someone forgot to tell you that the meeting room has no Internet access, WiFi
or otherwise. Your beautiful presentation is floating around in the cloud somewhere, probably on an Apple
server in North Carolina, and you have no access to it! iCloud is great, as long as you can connect to the
Internet.
Your immediate thought is “I am doomed”. Then you remember the tech tip that you read about how to
find your iCloud docs from a hidden directory on your laptop. Luckily you saved that tip on your file for
reference.
Tip: Find Your Hidden iCloud Documents
All your iCloud documents can be found locally in a carefully hidden folder in your user library called:
~/Library/Mobile Documents/
If you open this folder in the Finder (remember to use OPT+Go to reveal the Library folder), you will see
all the sub-folders containing your iCloud resident files. So to find the keynote file that you need for your
presentation just go to the folder containing the Keynote files:
~/Library/Mobile Documents/com-apple-Keynote/Documents/
Voila! Disaster has been averted because you can now open your Keynote presentation without the
Internet!
Bonus Tip
You can add this hidden folder to the Finder Sidebar for easy access. To do this you must:
1.

First create an alias for the Mobile Documents folder.

2.

Then you select the alias icon and drag it to the list of Favorites in the Finder Sidebar.

mmmm

Office 2013 — as noted in InfoManager
Microsoft has announced the the coming of the 2013 edition of Office.
However, there will NOT be a version for Macintosh.
Regardless, they are still expected to update Office 2011 so that it will have access to
SkyDrive and Office 365 which are features of Office 2013. Also while they did
anounce the Office for Surface, their tablets that run versions of Windows 8, they made no
statement one way or the other about putting Office on iOS devices. m m m
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6 Ways to Regain Disk

Space on Mac...

MacLife has posted this article
about regaining disk space on your
Mac. In these days of 500+ GB disks,
us old timers wonder how you could
possibly have disk space issues.
But it does happen.
This list of suggestions is
certainly good, even if many of
them are obvious to those who
aren’t new to the Mac.
1. Delete Apps
2. Delete Old Documents and
		 iChat Logs
3. Get Rid of Main Downloads
4. Remove Old Log Files
5. Find iTunes Duplicates
6. Reset Your Browser
Of course the article gives you
specific recommendations on how
to accomplish all these. There are
also utilities that can help you find
duplicate files on your drive as well.
See the complete article here.
mmmm

How To: Make The Most Of Your Mac’s Alt/Option Key
The option key – also labelled “alt” on many keyboards – on the Mac keyboard is something of a
mystery to new Mac users. Most people have no
idea what it does, but it’s actually one of the most
useful keys you’re likely to use. With the option key
held down, you can access a lot more information
and features on your computer that you’d otherwise spend a long time looking for. Here are some
of the best…
Give OS X The Boot
If you have more than one operating system installed on your Mac and want to quickly choose
between them when you boot up your machine,
simply hold down the option key when you hear
the ‘chime’. You’ll be presented with a choice between booting into Windows or Mac. Simply use
the arrow keys to select between them, and hit the
enter key to boot into the operating system of your
choice.
The Menu Bar’s Hidden Secrets
The menu bar, located at the top of your screen on
every Mac, houses important information such as
your Airport connection status, battery life and vol-

Installing Mountain
Lion: What you need
to know

by Dan Frakes,
Macworld.com

OS X 10.8—
better 		
known as
Mountain Lion is available only
as a download from Apple’s Mac
App Store. This makes it easier
and more convenient to upgrade
your OS than having to buy and
use a DVD or thumb drive, but it
also raises a number of questions,
and it presents upgrade obstacles
for some users. As I did last year
with Lion, I’ve compiled this guide
to getting and installing Apple’s
latest OS.
Before proceeding, be sure
to read the article in the August
MUGSHOT on getting your Mac

ready for Mountain Lion, which covers system
requirements and recommendations, as well as
a number of tasks you should perform before
upgrading that will help make the process go
smoothly.
This article covers the following subjects in
depth:
— Purchasing and downloading Mountain 		
		 Lion, including working with the installer on
		 other Macs
— Keeping the installer on hand
— Installing Mountain Lion
— Initial setup
— Post-install tasks
— Upgrade and installation challenges
— Purring along.
GO HERE for the full Macworld article.

ume, but when you click on these icons you get fairly
limited pieces of information. Take the Airport icon,
for example. When you click on it, you can view your
current networks and see networks around you, but
the information ends there. Try holding the option
key, and now click it. Instead of seeing the name of
the network you’re connected to, you can now see
information about the PHY mode (802.11a/b/g/n),
the channel the network is operating on, security
information and much more. The same is true for
some other icons, too. If you option-click the battery
icon, you can see the condition of your battery. Option-clicking the volume icon allows you to change
your output and input devices without touching
System Preferences. For power users and normal users alike, this is definitely a great time saver.
—A tip from AppleSlices, the newsletter of
The Villages Macintosh User Group. Many thanks!

The “i” Stands for
“Interplanetary”
By Michael Duplessis, SmallDog.com

For many years Apple has boldly gone where
no other tech company has gone before. Recent
screenshots, captured from the live stream of
Curiosity landing on Mars, show that their products
have also made inroads into NASA. Images of the
Entry, Descent and
Landing Operations
team at the space
agency’s Jet Propulsion Laboratory in
Pasadena, California
show several MacBook
Pros in use by the staff. Close up shots reveal that
they are running Mac OS X and being used for mission specific tasks. m The Curiosity rover also has
technology inside it that is Apple-related. The chip
that runs the on-board computer (actually two of
them for redundancy purposes) is a version of the
PowerPC processor that was used in the entire G3
line, from the Bondi Blue iMac to the iBook G3. The
biggest change to the chip is making it radiation resistant in order to survive Mars’ harsh environment.
This chip doesn’t have anywhere near the processing power of current Apple processors, in fact
people have noted that the current iPhone is more
powerful, but Curiosity has more than enough
power to complete its tasks. m m m m
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by Christopher Breen, Macworld.com

A reader finds himself stuck between old hardware and a new operating system. He writes:
“I have an older AirPort Express
Base Station. I recently installed
Mountain Lion and have found
that its version of AirPort Utility
doesn’t work with this Base Station—when I try to select the base
station I’m told that I need AirPort
Utility 5.6. I downloaded that version but when I attempt to install it
Mountain Lion tells me it’s not supported. What do I do?”
Mountain Lion is telling you
an untruth. That version of AirPort
Utility will run on your Mac (even
under Mountain Lion) and work

with your Base Station. The fly in the ointment in
this case is the installer. It simply refuses to install
this perfectly fine utility.

The workaround is to extract the utility from
the installer package. For this kind of thing I always
turn to CharlesSoft’s $20 Pacifist. Pacifist lives to
open “pkg” package files, .dmg disk images, and .zip, .tar, .tar.gz, .tar.bz2, and
.xar archives and extract their contents.
I ran this very package through Pacifist,
located the application, extracted it,
and it ran like a champ on my MacBook
Pro—allowing me to configure an ancient AirPort Express Base Station.
HOWEVER, a user writes about a workaround to save the $20:
Type in Terminal:
[code]hdiutil attach /path/to/myDMGname.dmg[/code]
then you will find the mounted .dmg in
/Volumes.
Doesn’t work with Mountain Lion? Nonsense
From there you can fish it out. m m m m

Mountain Lion: All about Sharing (if you want to))
By:Chris B, SmallDog.com

On of the most popular features of iOS on
iPhones and iPads is how easy it is to share
whatever you are working on. Mountain Lion
brings easy sharing to the Mac.
You’ve always been able to share the content on
your Mac, but Mountain Lion makes is easier and
more convenient than every before.
Actually, Mountain Lion expands on two different kinds of sharing:
• Sharing your content with yourself among
multiple Macs and iOS devices (iPhone, iPad)
• Sharing your content with your friends and
the rest of the world.
iCloud was released last summer and was integrated to some degree into Lion. In Mountain
Lion iCloud is integrated everywhere. The nice
thing about iCloud is that there is nothing to set
up. Once you log into iCloud, it seamlessly shares
your content among all of your devices. A couple
of examples of iCloud integration: you can now
save a document in an app and instantly see that
document on all of your other devices. iCloud can
also show all of the open tabs in Safari on all of your
devices so you can seamlessly move browsing from
one device to another.

What if you only have one Mac and no iOS devices?
Read this tip for more info. Also, check out the
iCloud series written last summer for more info on
iCloud.
Besides sharing your content between devices,
you can also easily share your content with the
world. The Share icon (see image @ left) is in practically every app. Clicking the share button brings
up a list of ways to Share: Email, Messages, AirDrop
and Twitter. Images can be shared with Flickr. It’s
not available now, but starting this Fall, you will be
able to share directly to Facebook as well.
(More on Messages and AirDrop in future tips.)
Here is what Mountain Lion is NOT—
A few folks out there are claiming that Apple is forcing you to share, and by extension making you give
Apple all of your logins to all of the services you use.
Not true at all.
I don’t tweet. I don’t read tweets. I don’t care
what my friends eat for lunch and I don’t need to
see a picture of a sandwich from Jimmy John’s.
Fair enough. I haven’t logged into Twitter and I can
calmly ignore the Twitter option on the sharing
options. In fact, I was never even asked to log in to
Twitter when I upgraded to Mountain Lion. You get
asked to log in to a service the first time you try to
use it. m m m m
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Equipment & Software used:
Mac G5 computer, Photoshop software,
Olympus E-500 DSLR camera.

The nature image artistry of
Tim Rankin—
“The very deeply colored sunset was
taken on our property just west of the
house and over a small lake.
The interesting thing about this
picture is that I had accidently left the
flash on and it illuminated the ground
in the foreground which I cropped out
but it made for a very dramatic
rendering of the sunset.
The other sunset shot was taken in
approximately the same location at a
different time, focal length and with a
very different sky.
The unusual small bloom with
the lavender blue on top of the white
petals is called morea .”
“Both of the shots of the
bromeliads were taken in one of my
greenhouses and the one with the red
petals has a most unique display of
stamens with some appearing to
be golden threads or cords.
Unfortunately, unlike most bromeliad
blooms this one doesn’t last but a few
days while the other bloom (red &
white star shaped) usually lasts better
than a month. ”
“Photoshop was used minimally,
with most adjustments confined to
tweaks in Levels". m m m m
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Nine tips for taming
text in Pages

Defining a new style from scratch is also a cinch:
format a paragraph or some characters by hand,
then click the plus-sign (+) button at the bottom
of the Styles Drawer. In the New Paragraph Style or
New Character Style window that appears, type in
a name, and click OK. For paragraph styles, you can
Control-click in the paragraph and select Create
New Paragraph Style From Selection.

Discover powerful word processing
features in Apple’s iWork app
by Christian Boyce, Macworld.com

Far more than Apple’s “version of
Word,” Pages (see review) is full of
powerful, time-saving features that
help you make great word processing documents quickly. Three of
the best are styles, templates, and
tables. Gain some familiarity with
these features and you’ll make better documents in less time than ever
before. Here are nine tips to get you
started.
1. Apply styles quickly
Use styles to format text quickly
and consistently. Paragraph styles
affect an entire paragraph, whether
you’ve highlighted every character
of it or simply clicked anywhere in
it. Clicking is faster, so don’t bother
with the careful selecting. To apply a
style, you can use the Styles Drawer
(View -> Show Styles Drawer), or better yet, use keyboard shortcuts. With
the Styles Drawer open, control-click
a style name and then, in the menu
that appears, choose Hot Key, and
select from the shortcut choices in
the menu. Now, applying a style is as
simple as clicking in a paragraph and
pressing this key.
2. Define your own styles
Want to redefine a paragraph style?
Format one instance of it by hand,
click anywhere in it, and then (in the
Styles Drawer) Control-click its name
and choose Redefine Style From Selection. Voila! Every paragraph with
that style is updated with the new
formatting. Character formatting is
similar—just be sure you’ve highlighted the formatted text before
Control-clicking the style name in
the Styles Drawer.

When you use Pages’ styles, it only takes a few clicks to
transform your document’s look.

3. Import styles from other documents
If you already have styles in one Pages document,
you can reuse them in another, saving time and
ensuring consistency in your written materials.
Choose Format -> Import Styles, navigate to the
document in the open dialog box that appears,
and then click Open. You’ll see a list of every style
in that document. While you can certainly import
them all, if you hold the Command key down you
can pick just the ones you want. You can choose to
replace duplicates with the imported styles, or to
retain both (in that case, a “2” is added to the imported style name).
4. Take advantage of templates

Templates give you an enormous head start on
your documents. Pages sorts its templates into two
basic groups: Word Processing (for text-centric documents like letters and reports), and Page Layout
(for things like newsletters, flyers, and brochures).
Each template contains professionally-designed
styles, and with the exception of the Blank templates, each contains placeholder text which you
can replace by clicking and typing.
Many templates contain more than one type of
page. For example, the Reports templates include
Covers, Tables of Contents, Chapter pages, Text
pages, and Bibliographies. Reveal these different
page types in the Template Chooser by slowly moving your mouse horizontally across a template’s
thumbnail. Once you’ve chosen a
template, add pages to your document using the Sections button (in
Word Processing documents) or the
Pages button (in Page Layout documents) in the Toolbar.
5. Include Address Book info
Some of the templates — for instance, Envelopes and Letters in
Word Processing, and many in the
Page Layout section—accept vCards, a standard
format for electronic business cards. If your template has placeholders for name and address, drag
in a vCard, or an Address Book entry, to fill in the
information automatically. Bonus tip: if you select multiple people in Address Book (or multiple
vCards) and drag them to an envelope template,
Pages will create an envelope for each one.
Documents created using a Business Card template show information from your own Address
Book card. To make this work properly, create an
entry for yourself in Address Book—complete with
Home and Work addresses—and then choose Card
-> Make This My Card.

Drag contacts from Address Book onto a Pages template to
quickly address a bunch of envelopes at once.
Pages’ Template Chooser lets you browse through templates for all different kinds of documents. Use the slider at
the bottom to adjust the thumbnails’ size.

6. Make your own templates
Choose File -> Save as Template to save a document (you guessed it) as a template. Cont’d. on pg 7
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Pages— Continued from page 6
worry about where to save it, as
Pages will save your template into ~/
Library/Application Support/iWork/
Pages/Templates/My Templates by
default. If (and only if) you accept
the default location, your template
will appear in the Template Chooser,
in a section called “My Templates,”
complete with auto-generated
thumbnails. This is a perfect place
for business-related documents
such as letterheads, envelopes, and
contracts. Share templates with colleagues by copying them to the corresponding folders on their Macs.
7. Tweak your tables
If you like things organized in neat
rows and columns, you’ll find Pages’
tables far simpler to use than those
in Microsoft Excel or Word. Add a table to a Pages document by clicking
the Table button in the Toolbar, or
by choosing Insert -> Table. A threecolumn, three-row table appears,
topped by a Header row. Need more
rows or columns? Control-click any
cell in the table and a pop-up menu
gives you options to add rows and
columns before or after the cell
you’re in. Need a super-lazy way to
add a row? Press Tab while in the last
cell of a table.
8. Enjoy table time-savers
If your table crosses a page break,
Pages puts a header row on the
second page too, repeating the
header text from the previous page
automatically. Edit a header row by
changing the text or formatting, for
instance, and Pages updates any
other headers associated with the
table.
While you can resize columns
(or rows) by dragging, most table
formatting is performed with the
Inspector (View -> Show Inspector).
Click the Table button in the Inspector to reveal an extensive set of
controls. My favorite: the option for
Alternating Row Color.
The Table pane in the Inspector
has two tabs: Table and Format. The
Format tab lets you format table

entries automatically, much as you might in Excel.
Select a cell, row, or column, then choose from options in the Cell Format menu, including Currency,
Percentage, and Date and Time. Once you’ve specified the formatting, Pages applies it automatically
as you enter data into those cells. For example, you
could type 7/27/62 and have Pages convert it to
Friday, July 27, 1962.
9. Easily apply formulas
You don’t need to leave Pages to apply simple
functions such as Sum, Average, and Count to your
table cells. For example, in a report about global
warming, you might have a table of temperatures
by year. With just a click in the Format section of
the Inspector’s Table pane you could compute the
average temperature for the 1980s, 1990s, and so
on. Don’t see the formula you’re looking for? Create any function you want using the Formula Editor option at the bottom of the Function menu.
Bonus: Pages’ functions are live and do not need to be
refreshed when the data changes.

Owners of pre-2011 Macs who want to use
the AirPlay feature aren’t completely out of luck
though. As Apple said years ago, “yeah, there’s an
app for that.” AirParrot is an app that sends the
H.264 encoding to the CPU. All that’s required is
Snow Leopard or newer OS, a multi-core processor
and for best performance a decent wireless router
that supports 802.11n and of course, an Apple TV.
AirParrot has a limited trial available here if
you want to check it out to see how it works. Be
aware, this may make your Mac run hot as according to AirParrot’s developer, David Stanfill, “AirParrot uses a non-trivial amount of CPU, which can
result in the fans kicking and the machine getting
a little warm.”

mmmm

Let’s say you find an address online that you know
you’ll need to access later. You can jot down the address on a piece of paper, manually add it to your
Address Book, or email it to yourself for later reference. FormalAddress (Mac App Store link) adds
another option, which saves time and is incredibly
convenient: it ports addresses from the web (and
other sources) to your Address Book in seconds.
When you come across an address that you want
to import to your Address Book, just copy the text
to your clipboard, open FormalAddress and paste
the address in the blank box on the left. Click the
“formalize” button at the center of the screen and
FormalAddress arranges the address, as it deems
necessary. This process works well, although I did
encounter some trouble with the formatting of
apartment numbers in testing.
Once FormalAddress has corrected an address,
you have the option of editing the address further
(where I fixed apartment number placement) before you finalize the address and send it to your
Address Book. Of course, you can edit any entry in
Address Book itself, too.
I found that FormalAddress did a good job identifying business addresses and personal addresses
when appropriate. FormalAddress automatically
filled in the business name and catalogued the entry as a business on its default settings. m m m m

AirPlay?
It’s Magic.
By Dawn D’Angelillo,
SmallDog.com

Every once in a while,
there is something new
in technology that comes out and it is just magical. Remember when the AirPort first came out?
I couldn’t wait to show friends who came to my
house…“watch this, I’m surfing without wires!”
The latest magic that has entranced me is AirPlay. AirPlay is a feature in Mac OS 10.8 (Mountain
Lion) that allows a Mac to wirelessly send a video
signal to an Apple TV. I put it to the test and was
blown away. Completely across the room, I was
able to display the demo screen top onto a giant
TV. No wires, no hassle — it just worked.
I started to do some digging about AirPlay and
found that magical though it is, not every Mac is
capable of putting the magic to work. It turns out
that AirPlay Mirroring will only work if you have an
iMac, MacBook Air or Mac mini from mid-2011, or a
MacBook Pro from early 2011, according to Cult of
Mac.
Simplified, it turns out that AirPlay encoding
(H.264) that needs to be done entirely on the GPU
(graphical processor unit) without involving the
CPU. The GPU that can handle the H.264 encoding
wasn’t put into Macs until 2011.

Editor’s note— There has been commentary in Macworld
magazine that AirParrot’s image quality is only “reasonably
good”. If you are considering AirParrot, try the 20-minute
trial version first, before laying out the cash. m m m m

Organize your Address Book with FormalAddress
By Brendan Wilhide, Macworld.com

A Quote:

Success is not final.
Failure is not final. It is the courage
to continue that counts.
— Winston Churchill
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Mars is now a wifi zone

Words With Martians

iRover apps now available

Exploring Mars has never been so easy.
Thanks to ipad, it’s touch and go”
from crater to crater, analyzing soil and
drilling rock to your heart’s content.

Tired of waiting for contact by alien
civilizations? Equip your iRover with
“Words With Martians” and get ready
for some out-of-this-world fun.

Design your dream mission. The App
Store has the world’s biggest selection
of apps for Extraterrestrial Exploration,
starting at only $69.95 million.

NASA taps Apple to
build next Mars lander
PASADENA, CA — Searching for
organic carbon compounds buried in soil 35 million miles from
home? There’s an app for that.
Faced with severe budget cutbacks, NASA has turned to Apple
for help with its next Mars lander.
The “iRover” is built upon iPad
technology. It offers more features
than the Curiosity vehicle currently exploring Mars, yet it will save
NASA more than $300 million.
In fact, the new rover itself will
only cost NASA $299. It’s the apps
that will allow Apple to further enrich itself.

Per its usual policy, Apple will take a 30% cut of
all apps offered at the new “Extraterrestrial Exploration” section of the App Store. Current choices include:
• SoilSucker. Ingests soil; analyzes for organic carbon compounds. $69.95 million.
• QuenchBot. Tests for evidence of water up to
one billion years ago. $99.95 million.
• RoverTurn. A free app that executes a righthand turn.
• RoverTurn Pro. Executes all other turns. $149.95
million.
Of course Apple retains the right to approve
apps before they are made available to NASA. The
App Store censors have already rejected DirtyDirt,
an app that would have used iRover’s robotic arm to
etch pornographic images into the Martian soil.
Thanks to the familiar iPad interface, NASA will

be able to save even more on personnel. For starters, the Jet Propulsion Lab is history. Over 400 technicians once required to run a Mars mission will be
replaced by four Pasadena retirees working on iPads
at home.
Apple’s participation will also radically modernize the Search for Extraterrestrial Intelligence (SETI)
program. For only 99 cents, the SETI organization
will sponsor the installation of iRover’s Words With
Martians app. Various SETI listening posts around
the world will monitor transmissions to detect when
and if anyone (or anything) on the Martian surface
starts a game.
A spokesperson for SETI expressed hope that “if
intelligent life is discovered, it won’t be so intelligent
that we can’t whoop it at Words.” m m m m
From: Scoopertino— all the news that’s fit to fabricate
Also thanks to P.D.
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OMUG Meeting Information—
The Ocala Mac User Group meets on the
2nd Tuesday of the month at:

St. George Anglican Cathedral—
Parish Hall
5646 SE 28th St., Ocala, FL 34471
See www.ocalamug.org for a map

OMUG Board of Directors—
President– N.C. Sizemore
ncsizemore@gmail.com • 291-8778
Vice President– Bobby Adams
badams0993@gmail.com • 274.0177
Secretary– Nancy Kirby
nkirby1944@embarqmail.com
Treasurer– Judy Rankin
judyrankin@mac.com • 821-2322
Director & Asst. Treasurer– Brian Voge
voge.brian@gmail.com • 622-8581
Director– Philip Davis
davistech@gmail.com • 369-8432
Director– Burt Stephens
burtstephens@gmail.com • 873-6177
Director– Al Sypher
aes@imageocala.com • 237-9501
Past President– Tim Rankin
rank.tim@gmail.com • 821-2322

Mac Users Helping Mac
Users—
OMUG Tech Support Team volunteers
will try to help with your computer and
software problems.
Please go to http://ocalamug.org/
tech-team.html for a list of help topics
and phone/email contacts for the
following member volunteers:
Bob Adams
Philip Davis (email ONLY)
Nancy Kirby
Dr. Roberto Putzeys
Judy Rankin
Tim Rankin
Brian Voge

OMUG Assignments—
Fifty-Fifty Raffle–
Earl Satterfield
Membership–
Nancy Kirby
MUGSHOT Newsletter–
Al Sypher
Program Coordinator–
Burt Stephens
Refreshments–
Della Marteny and
Ed Jaworowski
Webmaster and
Apple Ambassador–
Philip Davis

OMUG MEETING MINUTES: August 21st, 2012, called to order at 7 PM
Announcements & Introductions: President N.C. Sizemore welcomed 20 members and 1 guest. Our Treasurer, Judy Rankin, was back with us for a quick visit. Tim gave us an update on her progress and their visit to
Shands Hospital which will be overseeing her treatment. Tim also noted how quiet it has been at their house
due to Judy’s inability to speak much higher than a whisper. We all were happy to see both of them.
N.C. reported to the membership on the Virtual Board Meeting held via email during which the Board members
voted to add him, Bobby Adams and Brian Voge as check signers while retaining Judy Rankin as Treasurer and
adding Brian as Assistant Treasurer. The motions were carried by email vote.
Secretary’s Report: The minutes of the July meeting were approved as published.
Treasurer’s Report: Brian reported that there is $1,036.60 in the bank.
Burt Stephens reported on the upcoming programs through December and put out an SOS for program
ideas and presenters. If you have ideas or are willing to make a presentation, please contact Burt.
Phil announced that the Saturday workshops will begin in September with the first one concentrating on
basics and the new Mountain Lion OS.
Program 1: Updating Old Macs with SSD (solid state drives). Presenter: Bob Holloran.
Bob discussed the requirements for updating your older machines, which one are eligible for updates and
the steps you need to take to accomplish the update. The full presentation is available on the web site and
according to Bob it is not as difficult as it may appear. There is lots of information on this, so read the articles
and instructions carefully before you begin. Bob reports that his machines that were updated are significantly faster loading from the web as well as loading programs housed on your computer.
We enjoyed refreshments provided and served by Della Marteny, and some of Bob Holloran’s chocolate.
Program 2: Phil Davis shared his initial impressions of Mountain Lion. One caveat, when installing Mountain Lion as well as backing up your Mac, Spotlight must reindex your entire hard drive so you might want
to schedule this at night in order to allow it to be completed without interruption. Also, there is a new Share
feature in many Mountain Lion apps which allows you to send pages via email. He demonstrated the dictation feature which seems to work very well but you must be online to use this feature. Much more is on the
web site about this and other features that are new or changed in Mountain Lion as well as some reported
problems. • Phil also answered questions and answers from the audience on a variety of topics.
Raffle Results: 50-50 Raffle: $27.00 to Earl Satterfield • The Ultimate Quick Guide to Mountain Lion– Bobby
Adams • Take Control ebook of your choice– Brian Voge • 32 Gig Flash Drive– Sonja Lier
Meeting adjourned at 9 PM. Thanks to all who helped re-arrange the meeting room and put chairs away.
Respectfully submitted: Nancy Kirby, OMUG Secretary
Cover photo: Fall color impacts the foliage along the streambed. Location– Igloo Creek, aptly named considering its
icy water temperature, shot in mid-August from the park road, Denali National Park, Alaska.— Al Sypher

Oh... and one last thing— I think we would all agree that the whole concept and impact of the internet has

been moving very fast, as has the speed or the internet itself. How fast, and how strong? Take a look at some
facts over the last ten years.....
Year 2002
Year 2012
Number of users
569 million
2.27 billion
Number of websites
3 million
555 million
Typical time to download a song
12.5 minutes
18 seconds
And then there are the companies where
the “ship has sailed”
Blockbuster refused to buy Netflix and would not
rollout subscription-based membership
Borders— no online bookstore
Tower Records— slow to adopt to digital music

$5.5 billion in sales
1300 locations
200 locations

1 tombstone–Bankrupt
1 tombstone–Bankrupt
1 tombstone–Bankrupt

Source: your editor and theCHIVE website
Disclaimer—
The Apple logo is the property of Apple, Inc. The Windows logo is the property of Microsoft, Inc. All tradenames, trademarks, and registered
trademarks used herein are the property of their respective owners or companies. The information presented in this newsletter is for the
personal enlightenment of OMUG members and friends, does not constitute an endorsement, and is not to be used for commercial purposes.
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